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Printing
The SAS System under Windows uses the Windows Print Manager. This means you

can spool printed output from your SAS session (such as the contents of the PROGRAM
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EDITOR and OUTPUT windows and results of procedures and the DATA step) to the
Print Manager and manage this output in the same manner as you manage output
from other Windows applications. You can also take advantage of Windows TrueType
fonts and fonts supported by your printers. For details about using the Print Manager,
see your Windows documentation. “Producing Graphics” on page 139 discusses how to
route graphics from your SAS session to printers.

Printing from within a SAS Window
To print the contents of one of the SAS windows, make that window active (by

clicking on it) and select

File I Print...

From the Print dialog box (shown in Display 5.1 on page 126), you can choose from
several options:

� To print the contents of the currently selected window as text, click on OK .

� To print the contents of the currently selected window as a bitmap (that is, as a
picture of the window instead of as text), select the Print as Bitmap checkbox;
then click on OK .

� To print the contents of the currently selected window to a printer file (formatted
for the current printer), select the Print to File checkbox, optionally type in the
file name, and then click OK .

� To print the contents of the Windows clipboard, click on the field labeled Contents
of:. From the displayed listbox, select Clipboard (text) (or Clipboard
(bitmap) if you are printing it as a bitmap); then click on OK .

Note: The Print dialog box might differ somewhat from what you see on your
system, depending on which Windows operating system you use to run SAS, and on the
active SAS window. 4

Display 5.1 The Print Dialog Box
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The Print dialog box displays the destination printer’s name, status, and type of
printer. To change the destination printer, click on the Name combo box and select a new
printer from the list.

You can perform other printing tasks by combining the above methods. For example,
you can print the contents of the currently selected window as a bitmap to a printer file
by selecting both the Print to File and Print as Bitmap check boxes.

Here is a summary of the SAS-related options that the Print dialog box offers:

Contents of:
displays the name of the window whose contents you want to print. You can
choose between the currently selected window and the Windows clipboard. If you
select Print as Bitmap, you can also print a bitmap of the main SAS window or
of the entire screen.

Print to File
prints the selected window to a printer file. For example, if your currently selected
printer is a PostScript printer, the resulting printer file will be in PostScript
format. The Print dialog box prompts you for a filename.

Note that you cannot edit the resulting printer file; it is in a format readable
only by the type of printer specified in the Print dialog box. If you want to save the
contents of an application window to a text file without printer formatting, select
the File pull-down menu and then select Save As....

Print as Bitmap
prints the currently selected window as a bitmap instead of as text.

Force Bitmaps to Fill Page
scales the bitmap as needed to fill the entire printed page. The Print dialog box
window displays this checkbox only when you select Print as Bitmap.

Page range
specifies the range of pages of output to print. Selection is enabled if the current
window is a text window with selected text.

For more detailed information about the Print dialog box, click the ? button and
then click the area you want to know about.

Note: Although the Print dialog box offers a Collate option, this option is enabled
only if the printer supports collating on its own. The SAS System does not collate its
output pages. 4

Changing the Print Options
The Print Setup dialog box (shown in Display 5.2 on page 128) lets you control how

the SAS System prints information. For example, you use this dialog box to select the
page setup and the font used to print.

You can access this dialog box by selecting

File I Print Setup...

You could also click on Setup... from the Print dialog box. If you are using an
application that does not provide access to the menus, you can enter DLGPRTSETUP at
a command line. You can use the DLGPRTSETUP command to programmatically
specify every aspect of your printer settings. For details, see “DLGPRTSETUP” on page
284.
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Display 5.2 The Print Setup Dialog Box

The SAS System consults these sources for default printer settings (in order of
precedence, first to last):

� the SYSPRINT system option
� the system default printer (which you can select by adjusting the printer’s

properties in the Printers window).

Here is a summary of the information presented in the Print Setup dialog box:

Printer:
displays the name of the currently selected printer. To change the settings specific
to your printer, click on Properties . If you accessed the Print Setup dialog box
using the Setup... button on the Print dialog box, you cannot change the printer
destination from this dialog box.

Font
displays the current font. To change the font, click on Font... and select a new
font, style, and size from the Font dialog box.

When you change the font size, the SAS System recalculates the maximum
LINESIZE and PAGESIZE values displayed on the Print Setup dialog box.

Note: SAS tabular and columnar reports are formatted assuming the use of a
monospace font. Use of a proportionally spaced font might produce improperly
formatted reports. 4

Line Size and Page Size
display the maximum calculated line size and page size, respectively, for the
current printer and font settings. Although you cannot set these values directly
from this dialog box, you can adjust them by changing the page setup, the font,
and the destination printer. Click on Page Setup... to access the Page Setup dialog
box. From there, you can change the margins, page orientation, and papersize,
which in turn affects the line size, page size, and papersource. The LINESIZE and
PAGESIZE system options change when you click on OK .

Also, the Print Setup dialog box contains a graphic that depicts the current
page orientation and margin settings.

Note: The margin settings affect printed output only. 4

Use Forms
specifies whether to use SAS System print forms, as described in “Using SAS
System Print Forms” on page 133.
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To revert back to the default printer settings, click on Default .

Changing the Print Options Using the SAS System Options Window
To change the printer options using the SAS System Options window, you must know

the values of the printer name, font, and line and page size you want to use.
To open the SAS System Options window, select

Tools I Options I System

You can then make the following changes to the printing system options:
� To change the printer:

� select the Log and procedure output control folder and then select the
Procedure output folder

� With the right mouse button, click on Sysprint and select Modify Value
from the pop-up menu.

� Enter a printer name in the New Value text box and click on OK . The
printer name must be entered as it appears in the Windows Printer folder.
The printer name is case-sensitive.

� To change the Font:
� select the Log and procedure output control folder and then select the

Procedure output folder
� With the right mouse button, click on Sysprintfont and select Modify

Value from the pop-up menu.
� Enter a font in the New Value text box and click on OK

For valid values, see “SYSPRINTFONT” on page 469.
� To change the Line Size and Page Size:

� select the Log and procedure output control folder and then select the
Log and procedure output folder

� With the right mouse button, click on Linesize or Pagesize and select
Modify Value from the pop-up menu.

� Enter a line size or page size in the New Value text box and click on OK

Changing the Page Setup Options
The Page Setup dialog box (shown in Display 5.3 on page 130) lets you set the

margins, orientation, paper, and paper source for your printed output.
You can access this dialog box by:
� entering DLGPAGESETUP in the command bar
� selecting

File I Page Setup

� clicking on Page Setup from the Print Setup dialog box

You can also change the margins, orientation, paper, and paper source using the
LEFTMARGIN, RIGHTMARGIN, TOPMARGIN, BOTTOMMARGIN, ORIENTATION,
PAPERSIZE, PAPERSOURCE, and PAPERTYPE system options from the SAS System
Options window. To change these options:

1 Select
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Tools I Options I System... I Log and procedure output control

I ODS printing

2 Place the cursor over the appropriate system option, click the right mouse button,
and select Modify Value.

3 Enter a new value and click on OK

Display 5.3 Page Setup Dialog Box

Here is a summary of the information presented in the Page Setup dialog box:

Paper
lets you select the paper size and source of the paper (such as automatic selection,
envelop feeder, manual feeder, or printer tray) for printing. To change the paper
size or source, click in the combo box and highlight a selection. The paper size can
be one of the following; additional paper sizes may be supported. Note that not all
printers support these paper sizes:

LETTER
Letter, 8-1/2-by-11-inch paper

LEGAL
Legal, 8-1/2-by-14-inch paper

A4
A4 Sheet, 210-by-297-millimeter paper

CSHEET
C Sheet, 17-by-22-inch paper

DSHEET
D Sheet, 22-by-34-inch paper

ESHEET
E Sheet, 34-by-44-inch paper
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LETTERSMALL
Letter Small, 8-1/2-by-11-inch paper

TABLOID
Tabloid, 11-by-17-inch paper

LEDGER
Ledger, 17-by-11-inch paper

STATEMENT
Statement, 5-1/2-by-8-1/2-inch paper

EXECUTIVE
Executive, 7-1/4-by-10-1/2-inch paper

A3
A3 sheet, 297-by-420-millimeter paper

A4SMALL
A4 small sheet, 210-by-297-millimeter paper

A5
A5 sheet, 148-by-210-millimeter paper

B4
B4 sheet, 250-by-354-millimeter paper

B5
B5 sheet, 182-by-257-millimeter paper

FOLIO
Folio, 8-1/2-by-13-inch paper

QUARTO
Quarto, 215-by-275-millimeter paper

10X14
10-by-14-inch paper

11X17
11-by-17-inch paper

NOTE
Note, 8-1/2-by-11-inch paper

ENV_9
#9 Envelope, 3-7/8 by 8-7/8 inches

ENV_10
#10 Envelope, 4-1/8 by 9-1/2 inches

ENV_11
#11 Envelope, 4-1/2 by 10-3/8 inches

ENV_12
#12 Envelope, 4-3/4 by 11 inches

ENV_14
#14 Envelope, 5 by 11-1/2 inches

ENV_DL
DL Envelope, 110 by 220 millimeters

ENV_C5
C5 Envelope, 162 by 229 millimeters
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ENV_C3
C3 Envelope, 324 by 458 millimeters

ENV_C4
C4 Envelope, 229 by 324 millimeters

ENV_C6
C6 Envelope, 114 by 162 millimeters

ENV_C65
C65 Envelope, 114 by 229 millimeters

ENV_B4
B4 Envelope, 250 by 353 millimeters

ENV_B5
B5 Envelope, 176 by 250 millimeters

ENV_B6
B6 Envelope, 176 by 125 millimeters

ENV_ITALY
Italy Envelope, 110 by 230 millimeters

ENV_MONARCH
Monarch Envelope, 3-7/8 by 7-1/2 inches

ENV_PERSONAL
6-3/4 Envelope, 3-5/8 by 6-1/2 inches

FANFOLD_US
U.S. Standard Fanfold, 14-7/8-by-11-inch paper

FANFOLD_STD_GERMAN
German Standard Fanfold, 8-1/2-by-12-inch paper

FANFOLD_LGL_GERMAN
German Legal Fanfold, 8-1/2-by-13-inch paper

Margins
displays the amount of space to leave blank from the top, bottom, left, and right
edges of the paper. To change the margins, click in the text box and type in the
margin size.

Orientation
lets you select either Portrait or Landscape. Portrait prints vertically, and
landscape prints horizontally.

Previewing Your Output before You Print
To see how the contents of a window will appear as printed output, select the

window you want to preview and then select

File I Print Preview

Alternatively, you can click the Print Preview toolbar button.
In the Preview window, you can use the Next and Previous buttons to navigate

through the pages to be printed. The current page number and total number of pages
are displayed at the bottom of the window. You can also magnify your view of the
current page (to 100%) by clicking on Zoom , or by simply clicking inside of the page. To
reduce your view, click on Zoom or inside of the page again.

In the Print Preview window, you can navigate by using the following shortcut keys:
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Key Action in Full Page mode Action in Zoom mode

PgDn Advance to next page Scroll down on current page

PgUp Go back to previous page Scroll up on current page

Ctrl+PgDn none Scroll right on current page

Ctrl+PgUp none Scroll left on current page

Ctrl+Home Go to first page Go to first page

Ctrl+End Go to last page Go to last page

Note:

Not all SAS application windows support the Print Preview feature. 4

Using SAS System Print Forms
To use a form to print from the SAS System, select the Use Forms check box in the

Print Setup dialog box. When you print, the SAS System prints your output with the
current print form.

To specify a print form as the current print form, use the FORMNAME command, or
specify the FORMS option in your SAS configuration file or in the SAS System Options
window. To learn the name of the current form, issue the FORMNAME command with
no parameters.

Using the FORM Window
The FSFORM command opens the FORM window, in which you can define print

forms to use when you print SAS output. You can specify printer, page formats,
margins, fonts, and printer control language in a FORM entry.

SAS print forms are especially useful when you use the PRINT command from
within an interactive SAS session and when you print from SAS/AF windows.

To invoke the FORM window, issue the following command:

FSFORM catalog-name.form-name

See the SAS System online Help for more information about the FSFORM command.
While the majority of the frames in the FORM window are the same across all

operating systems, the first frame you see after issuing the FSFORM command is the
Printer Selection frame which lists the printers you are able to use under Windows.
Display 5.4 on page 134 shows the default information for this frame. (To navigate
though the FORM window frames, use the Next Screen and Previous Screen
commands located under the Tools menu.)



134 Printing with SAS Commands 4 Chapter 5

Display 5.4 Printer Selection Frame

The information in the Printer Selection frame is also site-dependent, so the printer
list at your site may be different from the one shown in Display 5.4 on page 134.

The Printer Selection frame appears only when you create a new print form. After
you create a form, it is stored in your user profile catalog or whatever catalog was
specified with the FSFORM command (entry type FORM). The next time you modify
this form, the Printer Selection frame is skipped. You cannot return to the Printer
Selection frame from the second FORM window frame.

Printing with SAS Commands
If you prefer entering commands to using menus, you can use the PRINT or SPRINT

command to print the contents of the active window. For more information about these
commands, see the SAS System Help.

Sending DATA Step Output to a Printer
You may want to spool your DATA step output to a printer instead of to a file. Use

the FILENAME statement and the PRINTER device-type keyword to accomplish this,
as in the following example:

filename myfile printer;
data _null_;

set mydata;
file myfile;
where city=’Cincinnati’;
put _all_;

run;

In this example, the PRINTER device-type keyword specifies to print the output to
the printer specified in the SYSPRINT system option. For more information on the
SYSPRINT system option, see “SYSPRINT” on page 468.

Sending Printed Output to a File
You can send your printed output to a file by selecting the Print to File check box

in the Print dialog box, and then specifying the name of a file to print to. This is not the
same as a save operation; the resulting printer file contains all the printer control
language necessary to support whatever options you have chosen with the Printer
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Setup dialog box, such as fonts and page orientation. In most cases, this printer file is
not readable with a text editor; it is meant only to be sent to the printer.

You can also route printed output to a file using the FILENAME statement, which is
useful for routing DATA step output. Here is an example:

filename myfile printer altdest=’c:\sas\results.dat’;
data _null_;

set qtr1data;
file myfile;
where sales ge 1000;
put _all_;

run;

In this example, the output from the DATA step is routed to a file, yet still contains
all the printer control information necessary for you to use your printer to produce
formatted output.

Another method of sending printed output to a file is to direct the output to the
FILE: device instead of a printer in the Windows printer Properties dialog box Ports
page. If you assign the FILE: device to a printer, Windows prompts you for a file name
each time you print. When you send output to a file, the contents of the file are
overwritten if the file already exists. For more information about changing printer
properties, see your Windows documentation.

Printing in Batch Mode
When you run SAS jobs in batch mode, you do not have access to the Print and

Printer Setup dialog boxes, but you can still take advantage of the Print Manager. Use
the SYSPRINT system option to specify your default printer (and the SYSPRINTFONT
system option to specify your printer font, if desired) as described in “SYSPRINT” on
page 468. For example, suppose your SAS configuration file contains the following
option:

-sysprint "f2hp5"

Then, your SAS program might contain the following statements:

filename myfile printer;
data _null_;

set schools;
file myfile;
where enrolled le 500;
put _all_;

run;

When you submit your job, the SAS System uses the SYSPRINT printer specification
to spool your output from the DATA step to the Windows Print Manager.

Default Printer Details
The SAS System looks for a default printer as follows (in order of precedence, first to

last):
� the SYSPRINT system option value
� the Windows system default printer.

The SYSPRINT system option is defined as the Windows default printer during SAS
installation.



136 Routing Procedure Output to a Web Browser 4 Chapter 5

To see the value of the SYSPRINT system, open the Print Setup dialog box either by:
� selecting

File I Print Setup

� enter DLGPRTSETUP in the command bar.

To change the SYSPRINT system option, see “Changing the Print Options” on page
127.

Routing Procedure Output to a Web Browser
With Version 8 of SAS, the Output Delivery System can create your procedure output

in HTML to be viewed in a web browser. If you have Microsoft Internet Explorer 4.0
(IE) or above installed, SAS displays the procedure output HTML file within the SAS
System Results Viewer window. If you are not using IE, the procedure output HTML
file is displayed in the web browser specified in the Preferences dialog box Web page.
Having IE installed lets you stay within the SAS System to view the HTML output.

For more information on using HTML within the Output Delivery System, see The
Complete Guide to the SAS Output Delivery System.

Configuring Preferences for HTML Output
For the SAS System to create an HTML file from your procedure output and to know

where to display the HTML file, you configure the Results and Web pages of the
Preferences dialog box.

To open the Preferences dialog box, select

Tools I Options I Preferences...

To configure the Results page of the Preferences dialog box:
� Click on the Results page.
� Select the HTML check box.
� Click in the Style box and highlight a style. The style defines colors and fonts to

display your output.
� Select where to save your HTML file. To save HTML files only while the current

SAS session is active, select the Use WORK folder check box. Saving HTML files
to a temporary folder is useful when you are testing a procedure and creating a
multitude of HTML files, as when you exit the SAS System, all temportary files
are deleted.

To save HTML files to a folder that is not deleted when The SAS System exits,
enter a path in the Folder text box or click on Browse to search for a folder.

� Under View results using, select Internal browser to view the HTML output
in a SAS window or select Preferred browser to view the HTML output in the
Web browser specified on the Web tab. If you do not have Microsoft Internet
Explorer installed, you must select Preferred browser.

To configure the Web page of the Preferences dialog box:
� Click on the Web page.
� To view the HTML output in the default browser that is configured in the

Windows Registry, select the Use default radio button.
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To view HTML from a web browser other than the default browser, select the
Other radio button and enter the browser’s path and file name, or click on Browse
to find the browser file name. For information on how to view the Windows
Registry, see your operating system documentation.

Using the Results Viewer Window
The SAS System uses the Results Viewer window to display ODS HTML output

when you select Internal browser from the Results page of the Preferences dialog
box . You can open any ODS HTML output listed in the Results window or any HTML
file on your system.

To open ODS HTML output in the Results Viewer:

1 Select the Results window.

2 Expand the Print folder containing the ODS HTML output by clicking once on +.

3 Double-click on the output you want to view.

You can compare one or more HTML files by opening multiple instances of the
Results Viewer. To open another Results Viewer window, from the Results window:

1 Click the right mouse button on the output data set name.

2 Select Open in New Window.

To open an HTML file on your system:

1 Click anywhere in the Results Viewer window.

2 Select Open from the toolbar.

3 Specify the HTML file in the Open dialog box.

The Results Viewer functions are available from either menus or the toolbar. The
following functions are available:

Back
displays the previous HTML file in the active Results Viewer window.

Forward
displays the next HTML file in the active Result Viewer window.

Save Background as...
opens the Save As dialog box to save the background image.

Select All
selects all text. Selected text can only be copied to the clipboard.

View Source
opens the current Results Viewer page in Notepad. Within Notepad you can view
or modify your HTML file. If you modify the HTML file, use Refresh to reload the
HTML file in the Results Viewer. To save changes to your HTML files, be sure
your HTML files are not saved in the WORK folder or other temporary folders.

Print
opens the Internet Explorer Print dialog box.

Refresh
reloads the current HTML page into the Results Viewer.

Properties
displays the Properties page for the current Results Viewer page.
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Routing Procedure Output and the SAS Log to a File

This section provides examples of routing SAS procedure output and the SAS log to a
file. Although not every method of routing output is included, the easiest or most
common methods are represented here. Most of this task is the same across operating
systems and is discussed in the SAS System Help. However, the specification of external
filenames and devices is system dependent. For complete information about the various
ways to reference external files, see “Referencing External Files” on page 106.

You can route your SAS procedure output or the SAS log to a file in one of several
ways. The method you choose depends on the method you use to run the SAS System,
the moment at which you make your decision to route the output or SAS log, and your
personal preference.

Some methods of sending SAS procedure output or the SAS log to a file include using

� the Save As dialog box, invoked either from the File menu, the pop-up menu for
the window that you want to save, or by entering DLGSAVE in the command bar.

� the FILE command

� the PRINTTO procedure

� various system options, including PRINT and ALTLOG.

The examples in this section illustrate only some of these routing methods. For more
information, see the SAS System Help.

Using the Save As Dialog Box
The easiest way to save the contents of the active window to a file is to select

File I Save As

from the main SAS window, making sure that the active window (for example, LOG or
OUTPUT) contains the output that you want to save. For more information about the
Save As dialog box, see “Saving Window Contents to a File” on page 31.

Using the PRINTTO Procedure
In batch SAS sessions, the SAS procedure output and the SAS log are written by

default to files named filename.LST and filename.LOG, respectively, where filename is
the name of your SAS job. For example, if your SYSIN file is MYPROG.SAS, the
procedure output file is named MYPROG.LST, and the log file is named MYPROG.LOG.
However, you can override these default filenames and send your output and log to any
file you choose. For example, suppose your job contains the following statements, which
assign the fileref MYOUTPUT to the file C:\SAS\FIRST.TXT. Then the PROC
PRINTTO statement tells the SAS System to send any upcoming SAS procedure output
to the file associated with MYOUTPUT.

filename myoutput ’c:\sas\first.txt’;
proc printto print=myoutput;
run;

Any PROC or DATA statements that follow these statements and that generate
output send their output to the C:\SAS\FIRST.TXT file, not to the default procedure
output file. If you want to change back to the default file, issue an empty PROC
PRINTTO statement like the following example:
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proc printto;
run;

Issuing these statements redirects the SAS procedure output to the default
destination (filename.LST). In this way, you can send the output and log from different
parts of the same SAS job to different files.

Note: If you route procedure output to a file, the resulting file may contain carriage
control characters. To suppress these control characters when you include the file in the
PROGRAM EDITOR, set the RECFM= option to P in the FILENAME statement. Note
that this affects the way the file is read into the PROGRAM EDITOR, not the file
itself. 4

If you want to send the SAS log to a specific file, use the LOG= option intead of the
PRINT=option in the PROC PRINTTO statement. For more information about the
PRINTTO procedure, see “PRINTTO” on page 365 and SAS Procedures Guide.

Note: When you use the PRINTTO procedure to route SAS procedure output or the
SAS log, the Status window does not reflect any rerouting of batch output but indicates
it is routing the procedure output file and log to filename.LST and filename.LOG. 4

Using SAS System Options
You can use SAS system options to route your SAS output or SAS log to a file. For

example, if you want to override the default behavior and send your procedure output
from a batch SAS job to the file C:\SAS\PROG1.TXT, you can invoke the SAS System
with the following command:

SAS -SYSIN C:\SAS\PROG1
-PRINT C:\SAS\PROG1.TXT

This SAS command executes the SAS program PROG1.SAS and sends the procedure
output to the file C:\SAS\PROG1.TXT. You can treat the SAS log similarly by using the
LOG system option instead of the PRINT system option. Two other related system
options, the ALTPRINT and ALTLOG options, are explained in “ALTPRINT” on page
407 and “ALTLOG” on page 407.

Note: The Status window does reflect the PRINT and LOG system options values
when recording where the procedure output and log are being sent. 4

Producing Graphics
For full details about using SAS/GRAPH software, see SAS/GRAPH Software:

Reference. For further details about using graphics and fonts with the SAS System
under Windows, see “Overview of Graphics Considerations” on page 511.

Producing Graphics on Your Display
In most cases, output is automatically displayed on your monitor when you run a

SAS/GRAPH procedure; it is not necessary to specify a SAS/GRAPH device driver.
Information about your graphics display is stored in a Windows information file and is
automatically used by the SAS System during an interactive SAS session.

Here is a simple example of how to produce a graphic:

data hat;
do x=-5 to 5 by .25;
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do y=-5 to 5 by .25;
z=sin(sqrt(x*x+y*y));
output;

end;
end;

proc g3d data=hat;
plot y*x=z/ctop=red;
title ’Cowboy Hat with G3D’;

run;
quit;

Display 5.5 on page 140 shows the output for this program:

Display 5.5 Cowboy Hat Program Output

If you use the DEVICE= option in the GOPTIONS statement to route your graphics
to a hardcopy device, and then you want to return to using your monitor to display
graphics, you must specify a driver. Submit the following statement to display graphics
output on your monitor:

goptions device=win;

You should also use the WIN device driver to produce graphics on your display when
you run your SAS job in batch mode.

If you specify that your program output is to be displayed in HTML, your graphic is
converted to a .GIF file and stored in the same folder as your SAS System data set. For
more information, see The Complete Guide to the SAS Output Delivery System.

Printing Graphics
You can use two methods to print output from SAS/GRAPH:
� Use a Windows printer driver for your device (supplied with Windows or with your

output device). This method allows SAS/GRAPH to send generic graphics
commands to the Windows printer driver, which then translates the commands to
a format the printer can use.

� Use a SAS/GRAPH printer driver to create a printer-specific graphics stream that
can be sent directly to the device. When you use a SAS/GRAPH printer driver
(also called a SAS/GRAPH native printer driver, meaning that it creates output
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using the printer language that is native to the target device), SAS bypasses the
Windows printer drivers and creates printer-ready output for your device. SAS/
GRAPH printer drivers on Windows are similar to those used by the SAS System
on mainframe and UNIX operating systems.

After SAS prepares output for a printer (by using either Windows printer drivers or a
SAS/GRAPH printer driver), the output is sent to the Windows Print Manager, which
then queues it for printing on the device of your choice. Figure 5.1 on page 141
illustrates how you can use the two sets of printer drivers within SAS/GRAPH to
produce output for a given device.

Figure 5.1 SAS/GRAPH Generic Printer Drivers versus SAS/GRAPH Native Printer
Drivers

The method that you choose depends on the output device you are using. For more
information, see “Choosing between a SAS/GRAPH Native Driver and the WINPxxx
Driver” on page 143. You can control both graphics printing methods by using either
the Print and Print Setup dialog boxes or the SYSPRINT= option and the GOPTIONS
DEVICE= statement.

Using the SAS/GRAPH Generic (WINPxxx) Drivers
To print a graphic using the SAS/GRAPH generic device drivers with the Windows

printer drivers:

1 From the File pull-down menu, select Print Setup and verify that the Printer
field in the Print Setup dialog box contains the correct Windows printer driver and
port. You can use the Print Setup dialog box to select any printer driver/port
combinations that you have installed in Print Manager. (To install new drivers
and port combinations, you can use the Add Printer Wizard in Windows, which
you can access through the Windows Control Panel.)

Alternatively, you can use the SYSPRINT system option to assign the
destination printer (for example, options sysprint=’HP LaserJet III’;).
Note that you may assign only printer driver names that have been previously
configured in Windows.

2 Run your SAS/GRAPH program with the following GOPTIONS: GOPTIONS
DEVICE=WINPxxx; The value of WINPxxx you specify depends on the type of
output device you use to print your graph:

WINPRTM
for black and white (monochrome) printers
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WINPRTG
for grayscale printers

WINPRTC
for color printers

WINPLOT
for plotters.

The orientation of graphics output is determined by the following:

� If you specify the GOPTIONS ROTATE= option, the output is oriented according to
the value you specify for ROTATE. For example, if you specify goptions
rotate=landscape, then the output is oriented as landscape, regardless of the
settings in the Print Setup dialog box.

� If you do not use the GOPTIONS ROTATE= option, the output is oriented
according to the settings in the Print Setup dialog box.

Note: Graphic printing is affected by the margins specified in the Page Setup dialog
box. If you modify the margins when printing graphics and your intention is to keep
the graphic proportional, be sure to change the Top and Bottom margins by the same
amount you change the Left and Right margins. 4

Using the SAS/GRAPH Native Printer Drivers

SAS/GRAPH native drivers produce output in the native language of the target
device. Examples of SAS/GRAPH native drivers include:

PS produces Postscript output

HPLJS3 produces output in the PCL5 language used by Hewlett Packard
LaserJet III printers

HP7550 produces HPGL output used by Hewlett Packard 7550 plotters.

After the SAS/GRAPH native printer driver has produced output in the native
language of the target device, SAS then routes the output to the device using Windows
Print Manager. The SAS System bypasses the Windows driver that is currently
associated with the target device, but it does respect the destination specified in the
Print Setup dialog box when deciding where to send the output.

To print a graph using a SAS/GRAPH printer driver, run your SAS/GRAPH program
with the following GOPTIONS:

goptions device=driver-name;

where driver-name is the name of a valid SAS/GRAPH device driver. For example,

goptions device=hpljs2;

formats the graph for the Hewlett-Packard LaserJet Series II printer. (You can view the
complete list of SAS/GRAPH drivers by submitting the PROC GDEVICE statement.)

To print a graph to a printer file (also called a graphics stream file, or GSF) instead
of directly to a printer, specify the GSFNAME option on the GOPTIONS statement with
the filename or fileref that points to where you want the output. For example:

filename graphout "graphpic.prn";
goptions gsfname=graphout gsfmode=replace

device=hpljs2;



Managing SAS Output 4 Importing Graphics from Other Applications 143

Printing and Previewing from the GRAPH Window
You can preview a graph that you create and, at the same time, format it for optimal

display on the device of your choice. To preview the graph before you print it, run your
SAS/GRAPH program with the following GOPTIONS statement:

goptions targetdevice=driver-name;

where driver-name is either one of the WINPxxx drivers or a SAS/GRAPH native driver.
By specifying a target device, SAS/GRAPH can format the graph with colors and

attributes appropriate for the target printer. To print the graph after it is displayed,
select the File pull-down menu and then select Print.

Note: If you do not specify a TARGETDEVICE before you create the graph, SAS/
GRAPH will prompt you (in the Print dialog box) for a device driver name when you
attempt to print the graph that you are previewing. (In most cases the WINPRTM or
WINPRTC driver is specified by default.) The graph colors, orientation, and sizing
might not be optimal for the output device you specify. 4

Choosing between a SAS/GRAPH Native Driver and the WINPxxx Driver
When deciding whether to use SAS/GRAPH native drivers or the WINPxxx series of

drivers, you need to consider such factors as the device you are using and the type of
output you want to produce. Note the following specific considerations:

� If no Windows printer driver is available for your device, use a SAS/GRAPH native
driver.

� If you have a device for which there is no SAS/GRAPH native driver, you should
use the WINPxxx driver, provided there is a Windows printer driver available for
the device. In cases where a new model of hardcopy device becomes available
between releases of the SAS System and the hardware vendor provides a new
Windows driver that uses new features of the device, you can use a WINPxxx
driver to take advantage of those features.

� If you want to use options such as HSIZE= or VSIZE= to customize the size
specifications used in your graph, using SAS/GRAPH native drivers usually
produces more reliable results.

� To use TrueType fonts in your SAS/GRAPH output, use one of the WINPxxx
drivers and specify the font just as you would specify one of the installed hardware
fonts for your printer. For more information about generating hardware fonts, see
“Overview of Graphics Considerations” on page 511.

Importing Graphics from Other Applications
SAS/GRAPH lets you import bitmap and vector graphics that were created by other

software packages. This provides a couple of benefits:
� You can create your graphic using another graphics editor, then import the graphic

into SAS/GRAPH to produce output on a specialized device.
� You can merge clip art and graphs from other applications with the graphs that

you create in SAS/GRAPH.

You can import bitmap graphics into these SAS System windows:
� GRAPH window. (The imported graphic becomes a new GRSEG entry in the

current catalog.)
� Graphics Editor. (The imported graphic becomes part of the current graph.)
� Image editor window. (The imported graphic becomes a new image.)
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The SAS System provides two ways to import bitmap graphics into SAS/GRAPH:

� From the application you used to create the graphic, copy the graphic to the
Windows clipboard; then switch to your SAS Session and paste the graphic into
the SAS/GRAPH window, as described in “Pasting Graphics from the Windows
Clipboard” on page 144.

� From the SAS/GRAPH window (or the Graphics Editor or Image editor) import the
graphics file using the Import Image dialog box, as described in “Importing a
Graphics File from within a SAS/GRAPH Window” on page 144.

To import vector graphics, use the GIMPORT procedure to import computer graphics
metafile (CGM) files. The imported files are stored as GRSEG catalog entries. This
method preserves the individual graphic objects in the imported graph, whereas the
other two methods treat the imported graphic as a single (uneditable) bitmap. For more
information about PROC GIMPORT, see SAS/GRAPH Software: Reference.

Pasting Graphics from the Windows Clipboard
If the tool you use to create the source graphics is a Windows application, then you

can use the Windows clipboard to copy the graphics to your SAS session.

1 From the application you used to create the graphic, select the graphic and copy it
to the clipboard using the copy procedures for your graphics tool.

2 Switch to your SAS session (or start your SAS session, if it is not already running).

3 With the SAS/GRAPH window active, select Paste from the Edit menu (or use the
GPASTE command). The graphic is pasted into the SAS/GRAPH window.

Importing a Graphics File from within a SAS/GRAPH Window
SAS/GRAPH provides import filters to translate graphics files created in other

applications to a format that you can use with the SAS System.
You can import graphics from other applications that produce files in any of the

formats shown in Table 5.1 on page 144.

Table 5.1 Graphics Import File Formats

Graphics File Format File Extension

Microsoft Windows bitmap BMP

Microsoft Windows metafile WMF

enhanced metafile EMF

Device independent bitmap DIB

JPEG format JPG

graphic interchange format (GIF) GIF

tag image file format (TIFF) TIF

PC Paintbrush PCX

Truevision Targa TGA

Encapsulated PostScript Interchange (EPSI) PS

Portable Network Graphics PNG

Photo CD image PCD
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Graphics File Format File Extension

Portable Pixmap PBM

X Window bitmap XBM

X Window dump XWD

To import bitmap graphics into SAS/GRAPH:

1 With the GRAPH window active, select the Import Image... menu item from the
File menu.

2 Use the Import Image dialog box to select the source directory and graphics file.
Ensure that the Format field shows the correct source format; this indicates which
import filter SAS/GRAPH will use. You can have the SAS System automatically
detect the file format of the file to import by selecting AUTO as the Format. Click
on OK .

Note: Automatic file format detection using AUTO does not detect the DIB,
EMF, and WMF file formats 4

You can also include IMAGE catalog entries in your graphs. For information about
including IMAGE catalog entries, see SAS/GRAPH Software: Reference.

Exporting Graphics for Use with Other Applications
The SAS System provides these methods of exporting graphics created in SAS/

GRAPH for use with other word processing or desktop publishing packages, or for
display on the internet or intranet:

� Export the graphics to a file from the GRAPH window, Graphics Editor, or Image
editor, as described in “Exporting a Graphic to a File from a SAS/GRAPH Window”
on page 145.

� Copy the graphics (or a portion of them) to the Windows clipboard, then paste the
contents of the clipboard into the target application (as a bitmap), as described in
“Pasting Graphics from SAS/GRAPH into other Windows Applications” on page
146.

� Create a computer graphics metafile (CGM) file for use with a specific graphics
package, using drivers that are included with the SAS System, as described in
“Creating CGM Files for Export to Other Applications” on page 146.

� Create a Windows metafile for use with another Windows application, as described
in “Creating WMF (Windows Metafile) Files for Export to Other Applications” on
page 148.

You can also use SAS/GRAPH to create GIF and VRML files for use with web
browsers, PDF files for use with the Adobe Acrobat reader, and many other useful types
of graphics files. For more information about how to create these types of files, see
SAS/GRAPH Software: Reference and the SAS online Help for SAS/GRAPH.

Exporting a Graphic to a File from a SAS/GRAPH Window
SAS/GRAPH provides export filters to translate graphics generated in SAS/GRAPH

into formats that you can use with other applications, such as spreadsheet and desktop
publishing programs.

You can export graphics from SAS/GRAPH in any of the formats shown in Table 5.2
on page 146.
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Table 5.2 Graphics Export File Formats

Graphics File Format File Extension

Microsoft Windows bitmap BMP

Microsoft Windows metafile WMF

enhanced metafile EMF

Device independent bitmap DIB

JPEG format JPG

graphic interchange format (GIF) GIF

tag image file format (TIFF) TIF

Adobe PostScript PS

Encapsulated PostScript Interchange (EPSI) PS

Portable Network Graphics PNG

Portable Pixmap PBM

To export a graph from the GRAPH window:
1 With the GRAPH window as the active window, select the File pull-down menu

and then select Export Image....
2 In the Export Image dialog box, select the target file format.
3 Specify the directory and filename for the exported graphic. Click on OK .

For more information about exporting graphics to a SAS IMAGE catalog entry from
the Image editor, see the SAS online Help for SAS/GRAPH.

Pasting Graphics from SAS/GRAPH into other Windows Applications
A quick way to export graphics from the SAS System to another Windows

application is to use the Windows clipboard. When you copy information from SAS/
GRAPH to the clipboard, you can then paste that information into any application that
accepts DIB, BMP or WMF input.

To copy information from SAS/GRAPH to the clipboard:
1 From the GRAPH window, hold down the left mouse button and drag the mouse

over the portion of the graph you want to copy. A selection box marks off the
selected area as you move the mouse. When you are finished, release the mouse
button.

If you do not select an area of the graph to copy, the next step will copy the
entire graph to the clipboard.

2 With the GRAPH window still active, press CTRL+C (or select Copy to Paste
Buffer from the Edit menu).

This copies the graph to the clipboard. From here, you can switch to the target
application and paste the graph (typically by using the Paste or Paste Special options
in the other Windows application). For more information about how to paste information
from the clipboard, see the documentation for the other Windows application.

Creating CGM Files for Export to Other Applications
You can export graphs from SAS/GRAPH to other graphics packages using drivers

developed specifically for those packages. When you use computer graphics metafiles
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(CGMs) as the medium of transport between packages, your graph retains its separate
components that you can independently edit and size. (The editing capabilities you can
use depend on the target graphics package.)

To create a CGM from SAS/GRAPH, set GOPTIONS as follows:

FILENAME fileref ’filename.CGM’;
GOPTIONS DEVICE=CGMxxxx GSFNAME=fileref

GSFMODE=REPLACE;

where CGMxxxx is the appropriate CGM driver for your target application, and
filename.CGM is the name of the file you want to create. Table 5.3 on page 147 lists the
graphics packages to which you can export CGMs, the appropriate drivers to use, and
the SAS Institute document that describes how to export the file and use it with the
target application. You access these documents free of charge from SAS Institute’s
Technical Support Division on the SAS Institute web site.

The driver names marked with an asterisk (*) are already provided with Version 8 of
the SAS System. For each driver that is not provided, the corresponding document
describes how to build the driver.

Table 5.3 CGM Drivers and Documentation for Popular Graphics Packages

Package Suggested Driver Document

Aldus PageMaker CGMAPMA* TS-252F

Aldus Persuasion CGMAPSA* TS-252D

BPS 35 MM Express CGM35 TS-252

Borland Quattro Pro (Windows) CGMBQWC TS-252J

Borland Quattro Pro (DOS) CGMBQA* TS-252

CorelDRAW 5 CGMCOR5L TS-252R

Frame Tech FrameMaker CGMFRCA* CGMFRGA*
CGMFRMA* PSCFRAME
PSGFRAME PSMFRAME

TS-252H

Harvard Graphics 2.12 for DOS CGHHG TS-252

Harvard Graphics 3.0 for DOS CGMHG3A* TS-252A

Harvard Graphics for Windows CGMHGWA* TS-252C

Harvard Graphics 3.0 for
Windows

CGMHG3L TS-252T

ImageBuilder CGMIMG TS-252

Interleaf 5 CGMCILFC* CGMGILFG*
CGMMILFM* PSILEAFC
PSILEAFG PSILEAFM

TS-252I

Lotus Ami Pro 3.0 CGMAM3C* CGMAM3G
CGMAM3M

TS-252M

Lotus Ami Pro 2.0 CGMAMIA TS-252

Lotus Freelance for DOS CGMFLALJ* CGMFLAPL*
CGMFLAPT*

TS-252

Lotus Freelance for Windows
2.0

CGMFL2C* CGMFL2G
CGMFL2M

TS-252K
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Package Suggested Driver Document

Lotus Freelance for Windows
1.0

CGMFLWA* TS-252

Lotus 1-2-3 4.0 CGM123C* TS-252N

Lotus 1-2-3 CGM123 TS-252

Lotus Office 97 CGMLOT97 CGMLT97P TS-252Y

Microsoft Word for Windows 6.0 CGMMW6C* CGMMW6G
CGMMW6M

TS-252L

Microsoft Word for Windows 2.0 CGMMWWC* TS-252B

Microsoft PowerPoint CGMMPPA TS-252E

Microsoft Office 97 CGMOFF97 CGMOF97P TS-252X

Polaroid CI3000 CI3000 TS-252

WordPerfect 5.1 for DOS CGMWPCA CGMWPCAP*
CGMWPGA CGMWPGAP*
CGMWPMA CGMWPMAP*

TS-252G

WordPerfect 5.2 for Windows CGMWPWA* TS-252

WordPerfect 6.0 for Windows
(Beta)

CGMWP6C CGMWP6G
CGMWP6M

TS-252O

WordPerfect 6.0A for Windows CGMWPGCA TS-252P

WordPerfect 6.1 Windows CGMWPGIL TS-252S

WordPerfect 6.0 for UNIX CGMWPUXL TS-252U

WordPerfect Presents for DOS CGMWPCA* CGMWPGA*
CGMWPMA*

TS-252G

Zenographics Pixie CGMPIX TS-252

Creating WMF (Windows Metafile) Files for Export to Other Applications
To learn how to export WMF files from SAS/GRAPH software, contact SAS

Institute’s Technical Support Division and ask for document TS-352C, which explains
this process for several target applications. For information about creating graphics for
use with Microsoft Office 97, ask for document TS-252X. For information about creating
graphics for use with Lotus Office 97, ask for document TS-252Y.
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